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3D Visualization of DICOM images for Radiological applications

®

Following this tutorial, you
will be able to load and
visualize DICOM volumes
with 3D Slicer, and to
iInteract in 3D with structural
images and models of the
anatomy.
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N Overview

Part I: Introduction to the 3DSlicer software

Part Il: 3D Data Loading and visualization of DICOM images
- Volume Rendering of thoraco-abdominal CT data
- Surface Rendering of MR head data

Part lll: 3D interactive exploration of the anatomy
- Exploration of the Segments of the liver
- Exploration of the Segments of the lung
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N Overview

Part I: Introduction to the 3DSlicer software
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Introduction to the
3DSlicer software
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®

3DSlicer

Powerful processing. Streamlined interface. 1 Extensible platform.

3DSlicer is a freely available open-
source platform for segmentation,
registration and 3D visualization of
medical imaging data.

3DSlicer is a multi-institutional effort
supported by the National Institute of
Health.
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®

3DSlicer

Powerful processing.  Streamlined interface. Extensible platform. ° 3DSI|Cer ve rS|0n 43 |S a mu|t|-
Ao e [ platform software running on
Windows, Linux, and Mac OSX

» Slicer is distributed under a
BSD license with no restriction
on use

« Slicer is a tool for research,
and is not FDA approved

Disclaimer _ _
It is the responsibility of the user of 3DSlicer to comply with both the terms of the license and with

the applicable laws, regulations and rules.
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An interdisciplinary platform

An open-source environment for An end-user application for
software developers clinical investigators and scientists

A software platform that is both easy to use
for clinical researchers and easy to
extend for programmers
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‘ﬁb 3DSlicer History

Image Courtesy of the CSAIL, MIT

1997: Slicer started as a
research project between
the Surgical Planning Lab
(Harvard) and the CSAIL
(MIT)
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3DSlicer History

@ Slicer 4 download statistics
sSlicer
ooooooooooooooooooooooooooooooooooooooooooo
Total matching downloads:
97702 aaaaaaaaaaaa
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< >
Date range: v
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eeeeeee type: -
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1997: Slicer started as a
research project between
the Surgical Planning Lab
(Harvard) and the CSAIL
(MIT)

2013: Multi-institution effort
to share the latest advances
In Image analysis with the
clinical and scientific
community
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NA-MIC Wiki

General

Center Components
»Algorith
» 1

Resources

A multi-institution: NA-MIC, NAC, NCIGT

National Alliance for Medical Image Computing

A National Center for Biomedical Computing
Funded under the NIH Roadmap Initiative

Modeling the path of the tamping iron through the Gage skull and its effects on white matter

structure Read more.
. .

el -

B/

The National Alllance for Medical Image Computing (NA-MIC) is a
multi-institutional, interdisciplinary team of computer scientists, software
engineers, and medical investigators who develop computational tools for
the analysis and visualization of medical image data. The purpose of the
Center is to provide the infrastructure and environment for the development
of computational algorthms and open-source technologies. and then
oversee the training and dissemination ~**=~=
research community.

10f 24 Photos

Supported by the National Institutes of

Information about collaborating with NA

xsNa2012 4

The 96th Annual
Meeting of the
Radiological Society of
North America will be
held on November
25-30, 2012 at
McCormick Place, in
Chicago, IL RSNA s an
international society of
radiologists, medical
physicists and other
medical professionals
with more than 50,000
members across the
globe

ORead more.

ONEWS ARCHIVE

Neuroimage Analysis Center

About the NAC

Resources

Pl: Ron Kikinis, M.D.

[l Prodicted {
B Actua i

The Neuroimage Analysis Center (NAC) develops image processing and analysis techniques for
basic and clinical neurosciences. The NAC research approach emphasizes both speciic core
technologles and collaborative appiication projects. The activities of the NAC are centered at the
Harvard Medical School and the Surgical Planning Laboratory at the Brigham and Women's

). with collaborators throughout the United States and the rest of the world

for research center supported by the National Center for Research Resources
r 2011) and the Institute of Blomedical Imaging and Bioengineering (NIBIB)
© National Institutes of Health

I

DYy S ¢

\»L CENp,
%‘5
%
&
‘7% b
"Ilmac
NCIGT Wiki
About Us
» Overview

» Research Labs
> Research Cores

Research
Projects

» DBPs
» People

Resources

» Publication DB

» Image Gallery

» Downloads

» AMIGO

> News and Events
» Contact Us

Advanced Multimodality Image Guided Operating (AMIGO) Suite
The Advanced Mulnmodallly Image Guided Operanng (AMIGO) Sulte |s an innovative

surgical and i that s the clinical st bed of the
National Center for Image-Guided Therapy (NCIGT) at the Brigham and Women s
Hospital (BWH) and Harvard Medical School. The AMIGO is an integrated, 5,700 square
foot area divided into three sterile procedure rooms in which a multidisciplinary team will
treat patients with the benefit of intra-operative imaging using multiple modalities. More.

© Featured Image Archive

The National Center for Image Guided Therapy (NCIGT) is a Biomedical
Technology Resource Center supported by the NCRR and NIBIB institutes

Pls: Ferenc Jolesz, M.D.,
Clare Tempany, M.D.
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Slicer: Behind the scenes

®

. —— Slicer is built every

e e |
n|ght on Windows,
. Mac and Linux

platforms

Windows7-VS2010-320its-QT4.7.1-PythonQt-With-Tel-CUI-

factory-win7 kaware 00 @
SnowlLeopard-g++4.2.1-64bits-QT4.7-PythonQt-With-Tck-CU-
factory-mac-64bits. kitware R D@

Linux-ge+4.4.3-64bits-QT4.7-PythonQt-With-Tel-CLI-Release
P
Windows7-VS2008-64its-QT4.7.1-PythonQt-With-Teh-CLI-
Release &

S: QT4.7.1-PythonQt-With-Tel-CU-
Release ¥«

factory-ubuntu-64bits. kitware

factory-win7 kaware 10003

factory-win7 kaware

Suld Neme Buld Time.
t Wogccaon«,.r.ommwm-mmuu 11 hours ago

youplsclutah.edu ’mcm.a.o«mnm-wm-rm~ FEe
ers aware Linux-g++4.4-QT4.6.3-PythonQt-CLI-Release & $hours ago
r~—y ’L:Xwg.mn.vmmuwu-vwmm 11 hours ago
factory-bun-Sibkaxtwere Linux-g++4.4.3-6415-QT4.7-PythonQt-With-Tel-NoCLI- 11 hours ago

Coverage-Reloase ‘A
Linux-g++4.3.3-QT4.7-PythonQt-With-Tc-NoCLI-Release

sagarmatha. kitware

Buid Name

OpenSuse-C++4.5.0-64bits-QT4.6.3-PythonQt-With-Tel-NoCLI-
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Slicer Training events

l .
[
3 h |
i "
‘

Hands-on training
workshops at national
and international venues

More than 2,700
clinicians, clinical
researchers and
scientists trained since

2005
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Slicer Training events

, :
.
D f) |
i . [
‘

— RSNA 2008, 2009, 2010,
2011, 2012,2013

— MICCAI 2008, 2009, 2011,
2012,2013

— SfN 2009, 2011

— SPIE 2012, 2013

— CAOS 2010

— CARS 2010, 2012, 2013

RSNA 2011
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ﬁ) RSNA Activities

Hands-on refresher courses

« 3D Visualization of DICOM images for Radiology Applications
« Quantitative Imaging for Clinical Research and Practice

Quantitative Imaging Reading Room Exhibit

« 3DSlicer: An Open Source Platform for Segmentation,
Registration, Quantitative Imaging, and 3D Visualization of
Multi-Modal Image Data.
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N Overview

Part Il: 3D Data Loading and visualization of DICOM images
- Volume Rendering of thoraco-abdominal CT data
- Surface Rendering of MR head data
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®

Welcome to Slicerd4

8 00 3D Slicer 4.3.1
ga & & Im Aw "0 Q| AEGHEHIE |t B8 wh +-@
e® 1
@5()5 .....
Welcome

(Si5a, Load DICOM Data

(5 Load Data
4 Customize Slicer

@ Download Sample Data
~ Feedback

~ Share your stories with us and let us know about how 3D Slicer has enabled your research.
We are aly improving 3D Slicer, and every submission will be carefully read.
See more at http://goo.gl/6BvcHm.
» About
» The in Wind
» Loading d Saving
Display
Mouse & Keyboar
ocumentation &
Acknowledgment

To start Slicer, select Start > Programs—> Slicer4-3.1-1 (win64)

Q
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Navigating the Application GUI

The Graphic User
Interface (GUI) of Slicer4
integrates four
components:

the Menu Toolbar

the Module GUI Panel
the 3D Viewer

the Slice Viewer

+ o .Menu &:Toolbar

g
(s
=4
siss) Load DICOM Data
& Customize Slicer ©
L]
— 3D Viewer
nd S
ard
itorials
» Acknowledgment
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ACPC Histogram Matching 4 Transforms
View Help Add Scalar Volumes Image Label Combine Vector Demon Registration (BRAINS)
é Modules: . | 2 Welcome to Slicer Affine Registration Intensity Difference Change Detection (FAST) Vector to Scalar Volume
All Modules Annotations Label Map Smoothing I View Controllers
2 Annotations AllasTests o Label Statistics ViewControllers Slice Interpolation Bug 1926
@ 3DSlicer BSpline Deformable Registration labelToggleBug2049 ® Volume Rendering
4 Data BSpline to deformation field Linear Registration
& DICOM @ Cameras Mask Scalar Volume @ Volumes
N - N N Voting Binary Hole Filling Image Filter
We I Co n ~ Editor Cast Scalar Volume Median Image Filter WebGL Export
© Models chan_geTracksr Merge Models 2\ Welcome to Slicer
- # Scene Views Charting Model Maker
| ks Load DICOM Data| CheckerBoard Filter Model To Label Map
[ = Slicer | view C ® Colors © Models
© Volume Rendering Create a DICOM Series Multiply Scalar Volumes
» About @ Volumes @ Crop Volume MultiVolumeExplorer
— 1 Curvature Anisotropic Diffusion MultiVolumelmporter
» The Main Window a to Slicer « Data P NA4ITK MRI Bias correction
» Loading and Saving Wizards DataProbe 3¢ OpenlGTLinkIF
-] P Demon Registration (BRAINS) Orient Scalar Volume
» Display ] Reg's‘m”"" 5 DICOM Otsu Threshold Image Filter
> Mouse & Keyboard | Segmentation DICOM to NRRD Converter Otsu Threshold Segmentation
Diffusion Diffusion Tensor Scalar Measurements Performance Tests )
aT Diffusion Weighted Volume Masking PET Standard Uptake Value Computation
—— DTlexport Probe Volume With Model
¥ Acknowledgment | e DTlimport % Reformat
] C:n:::erso el DWI Joint Rician LMMSE Filter Resample DTI Volume
Endoscopy DWI Rician LMMSE Filter Resample Image (BRAINS)
Utilities DWI to DTI Estimation Resample Scalar Volume
Developer Tools DWI to Full Brain Tractography Rfegample_ Sca!arNemorlDWl Volume
Legacy DWI Unbiased Non Local Means Filter Rigid Registration ) o
Testing ~ Editor Robust Mull.lre.soluuon Affine Registration
EMSegment Command-line Robust Statistics Segmenter
Work in Progress M with Atlas RSNA2012Quant
& EMSegmenter without Atlas RSNA2012Vis
(Issue 2428)
n Growing Segmentation
ic
-ashBug2590
lar Volumes
-alar Volume
Display
Interactive Seeding
Label Map Seeding
ML Files to New EMSegmenter Standard
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ACPC Transform General Registration (BRAINS)
Add Images Gradient Anisotropic Diffusion Statistics Segmentation
2 Annotations Grayscale Fill Hole putation

BSpline to deformation field Grayscale Grinid Peak B
Gameras Grayscale Model Maker a Scene Views

Cast Image Histogram Matching Simple 10 Test
ChangeTracker Image Label Combine Simple region growing
CheckerBoard Filter Intensity Difference Change Detection (FAST)
Colors Joint Rician LMMSE Image Filter

Create a DICOM Series Label Map Smoothing
Crop Volume Label Statistics oT

Curvature Anisotropic Diffusion Lingar registration
DICOM MR Bias Field Correction

DWI to Full Brain Tractography :""5“ :"‘39: T Tractography Labelmap See
a ISR TONT DNTOSTON YYOTgTog Arges Transform MRML Files to N

EMSegmenter Standard i

Transforms
Unbiased Non
§ View Controllers
ements o " @ Volume Rendering
‘ommand-iine " @ Volumes g
i EMSegmenter with Atlas ‘ Voting Binary Hole Filling b7
& EMSegmenter without Atlas Welcome 1o Slicer
Editor
Endoscopy
Event Broker
Execution Modei Tour o S i
Expert Automated Registration S ! £
Extract Skeleton
Fast Affine registration o e Vot Mol (Pain) e
Fast Nonrigid BSpline registration ’ W
on o !
fon

ng (BRAINS)

Al Means filter for DWI

Resampl
Resample Scalar Volume

Resampie Scalar/VeclorfOWi Voiume
Rician LMMSE Image Filter

Slicer4.3.1 contains
more than 100
modules for image
segmentation,
registration and 3D
visualization of
medical imaging data
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Loading a DICOM Volume

Slide 21

©2012-2013 Surgical Planning Laboratory, ARR



ﬁb Loading a DICOM volume

ga Modules: . |2 Welcome to Slicer = 0@ O |5 9 HE E

Open the directory
C:/3DSlicerData :RSNA2013/3DVisualizationDICOM_Tuesday_Dec3

-
«
@
F
«

aef

[5&s Load DICOM Data [oecy Load Data
) da
& Customize Slicer © Download Sample Data 28 " e
~ Feedback 7
(1 e
hoc
D rag an d dro P the.folder.‘dataset1 _Thorax-Abdo :
research. — B
We are always interested in improving 3D Slicer, and every submission will be carefully 0
INtOo Slicer

ut
See more at http://goo.gl/6BvcHm. Date Modified M

Today 7:10 PM
(3 Quantitativelmaging_Sunday_Dec1_2013 Today 7:05 PM -~ Folder
dicom-data Today 7:17 PM -~ Folder
Today 7:06 PM — Folder
Nov 1, 2012 8:23 PM - Folder
Today 7:06 PM - Folder
Today 7:06 PM

(] dataset2_MR-Head \Today 7:06 PM
Display Today 7:06 PM Folder

About

The Main Window

| dataset4_CT-Chest

5 i .
Loading and Saving (] dataset3_CT-Liver

Mouse & Keyboard

Documentation & Tutorials

Acknowledgment

1 of 9 selected, 30.07 GB available

~ Data Probe
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oading a DICOM volume

3D Slicer 4.3.1

8 2 & ot . Dckomernsier 4= 0.0, 4 @ WIE | t-/8 m 4o @ e

e® 1

3DSlicer

Welcome

(G5 Load DICOM Data Load Data

¢ Customize Slicer ] © Download Sample Data ®e00 [ data

)@ E == ol () (8- (=-) (=]

~ Feedback

_ Share your stories with us and let us know about how 3D Slicer has enabled your =
research. : “‘[m

We are always interested in improving 3D Slicer, and every submission will be carefully

read. Select a reader dataset]_CT-Thorax-Abdomen
Select a reader to use for your data?
See more at http://goo.gl/6BvcHm.
Load directory into DICOM database + ‘ Name | Date Modified Kind
» About N &3 zip Today 7:10 PM Folder
= (2 Quantitativelmaging_Sunday_Decl_2013 Today 7:05 PM Folder
» The Main Window (2 dicom-data Today 8:09 PM Folder
(2 3DVisualization_Tuesday_Dec3_2013 Today 7:06 PM Folder
s " - » [ dicom-database Nov 1, 2012 8:23 PM Folder
Loading and Saving > (i datasetd_CT-Chest Today 7:06 PM Folder
> [ dataset3_CT-Liver Today 7:06 PM Folder
» Display L Today 7:06 PM Folder

Today 7:06 PM Folder

» Mouse & Keyboard

» Documentation & Tutorials

10f 9 selected, 27.5 GB available

A pop-upmv;'/mindow appears:
Select Load directory into DICOM database and click on OK
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oading a DICOM volume

Slicer starts loading the DICOM images

D Slice
DICOM Details
f@ @ Module
Import Export Query Send Remove LocalDatabast 9 /Users/spujol/workshop/RSNA2013/data/dicom-data
m Name ~ Age Scan Date Subject ID  Number Institution  Referrer Performer
3DSlicer
>
> Help & Acknowledge?
~ Servers |
Start Listener when S| A
~ DICOM Database and ”
1 the
hoc
ul the
~ Recent DICOM Activif -
| 1.
0 series added to databz 0
s > 0
DICOM Data Reader Warnings = u:;
¥/ 6: CT_Thorax_Abdomen Scalar Volume -
6: CT Thorax Abdomen for cont... Scalar Volume | - -
800
/Users/spujol/workshop/RSNA2013/data/3DVisualization_Tuesday_Dec3_2013/datasetl_CT-Thorax-Abdomen/IM-0001-0262.dcm al
tTe
B "
Mo e: CT_Thorax_Abdomen for cont... Scalar Volume -
- is
e YAV VP S R S, .
Uncheck All Load Selection to Slicer Close
<
2 Make DICOM Browser Persistent

©2012-2013 Surgical Planning Laboratory, ARR
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oading a DICOM volume

3D Slicer 4.3.1
DICOM Details

ga & & Mod

Import Export Query Send Remove LocalDatabast 9 /Users/spujol/workshop/RSNA2013/data/dicom-data
r\ Name ~ Age Scan Date Subject ID  Number Institution  Referrer Performer
30Slicer
L~ # patientl patient1_ID
> Help & Acknawledg
¥ Servers |
Start Listener when
~ DICOM Database 3
¥ Recent DICOM Act_ D
0 series added to dat;
< ¥
| nieoaanae Bandar Warnings
¥ 6:CT_Th
6:CT Th \i“) Directory import completed.
6: CT_Th 1 New Patients
6:CT_Th 1 New Studies
| 1 New Series
6: CT_Th 291 New Instances
1 6: CT_Th
6: CT_TH
6: CT_TH #:0000mm B G 7:0.000mm

< e Click 0N OK once the
directory import is
completed

~ Data Probe

Q)
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Loading a DICOM volume

& [Module 22

DDDDDDDDDDDD
| Import Export Query Send Remove LocalDatabast 7 /Users/spujol/workshop/RSNA2013/data/dicom-data
{'::, Name ~ Age Sc: Date Subject ID  Number Institution  Referrer Performer
ssssss
-4 = patientl patient1_ID
| = CT Thorax Abdomen 2005-06-01 6936864 OEfZQhRfY...
> Help & Acknowledgevj CT_Thorax_Abdomen CT 6 2005-06-01 HEART 14
~ Servers |
|
Start Listener when S|
~ DICOM Database a@
|
~ Recent DICOM Activil

0 series added to databi
<

The patient1 DICOM dataset appears in the DICOM browser

Click on ‘patient1’ to display the file hierarchy, select the
DICOM volume CT_Thorax_Abdomen_CT

Uncheck All Load Selection to Slicer Close
Make DICOM Browser Persistent

~ Data Probe

o
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Loading a DICOM volume

®00

bt e e s e e OliCET displays the snapshots of the DICOM images

- patient1

e Rndanen T of the CT_Thorax_Abdomen_CT dataset

DICOM Data Reader Warnings 5
CT_Thorax_Abdo... Scalar Vol... =
CT_Thorax_Abdo... Scalar Vol...

CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...

L CT Thorax Abdo... Scalar Vol... S
Image 19 all Uncheck All || Load Selection to Slicer Close
" Make DICOM Browser Persistent

PDDDDDDADDDDDD DD

Image 18
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Loading a DICOM volume

Click on Load Selection to Slicer to

Import Export Query Send Remove

e Pree s pwe S v ogd the DICOM volume into Slicer

- CT Thorax Abdomen 2005-... " 6936864 OEfZQ...
- CT_Thorax_Abdomen CT 6 2005-... HEART 14

(note: this may take a few minutes)

DICOM Data Reader Warnings 5
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT_Thorax_Abdo... Scalar Vol...
CT Thorax Abdo..  Scalar Vol S

Image 15 Image 16 Image 17 Image 18 Image 19 g Uncheck All Load Selection to Slicer Close
! e — " Make er istent
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Loading a DICOM volume

1800 3D Slicer 4.3.1
B2 B 22 |Modules : . [#Dicom =00 IR kG H E t-EwRl+-@@
e® 1

~ Servers

Listene
r when Sli
tabase
[ Browst
Activity

0 series added to database in the past hour

Slicer displays the axial, coronal and °

sagittal slices of the DICOM dataset Slide 29



Loading a DICOM volume

806 3D Slicer 4.2.0-rc1-2012-10-28

FEile Edit View Help

g2 % & |Modules: - [=DICOM " QO0 |9 «@ <2 Bt 8 w -
ox [l

@ 3DSlicer

» Help & Acknowledgement

~ Servers

Start Listener J
Start Listener when Slicer Starts
~ DICOM Database and Networking
Show DICOM Browser

~ Data Probe

| Red RAS:(-79.4,290.2,-188.5) Axial Sp: 2.0
L None 0
F None

0
B6: CT_Thorax_Abdomen (426, 17, 145)-956

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

Select the Active Volume S—

licer has a series of
6:CT Thorax Abdomen )
T et e window/level presets

S Active Volume 6: CT_Thorax_Abdomen + .
» Volume Information ava I I a b I e

~ Display

Lookup Table: B Y D
Interpolate: v
Window Level editor prese

1 ENH £2
W: 350 : Manual W/L +|L: 40 S
Threshold: Off E
-1434 3480 .
» Histogram

Click on the Window Level
Preset CT-abdomen, or
adjust manually the Window
and Level using the Manual
WI/L slider
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Loading a DICOM volume

F|Ie Edn View Help
g2 2 2 Modules: . @Volumes

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

Position the mouse cursor
over the red banner in the
Red Viewer to display the
slice menu.

Click on the Links icon &,
to link the slice controls
across all Slice Viewers.
Click on the Eye icon to
display the three anatomical
slices in the 3D Viewer

=00 9O ed < tv| @ M R4

ox @1

Link/Unlink the sl|ce

controls (except
Pascales) across all

Slice Vi

_/, ARR
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°/) Loading a DICOM volume

00

(2]

File Edit View Help

ga & & |Modules: . @Volumes = Q. PO ed 2 t - Ao R,
1

@,s \\\\\

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display
Lookup Table:| ¢ Grey

Interpolate: v
Window Level editor presets:

Wil @ a

W:350 7/|Manual W/L +||L: 40
Threshold: Off ¢
-1434 3480 . =T

N 6:CT...domen =

The three anatomical
slices appear in the 3D
viewer. Use the right-
mouse button in the 3D
Viewer to zoom in and out
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Loading a DICOM volume

8 00 3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help

g3 & & Modules: .| @Volumes (" Q0O PO @@ 2 HIt @ W 5 -

Q 3DSlicer

» Help & Acknowledgement
Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display
Lookup Table: [lF Grey

Interpolate:  ~
Window Level editor presets:

Wi B @ A

W:350 I/|Manual W/L +||L: 40
Threshold: Off <
-1434 20 113480 .

Use the left-mouse button
in the 3D Viewer to rotate
the 3D volume

wmr

©2012-2013 Surgical Planning Laboratory, ARR
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Loading a DICOM volume

.00 30 Slicer 4.2.0-1c1-2012-10-28 ]
File Edit View Help

% |Modules: . |® Volumes

g 3DSlicer

» Help & Acknowledgement
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Loading a DICOM volume

8 00 3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help
ga £a 'Modules: . '@ Volumes

@ OSlicer

» Help & Acknowledgement

Active Volume 6: CT_Thorax_Abdomen
» Volume Information

~ Display gl | i
Lookup Table:[ I Grey N & Red slice only ‘,
. = Yellow slice only
Interpolate: v . A
Window Level editor presets: B Green slice only
Tabbed 3D

= Tabbed slice

Click on the Slicer layout T |
menu icon, and select the  gggg-roe o
Conventional Widescreen

layout

~ Data Probe

wmr
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Loadlng a DICOM volume

Use the red ~00 00 s e mIimnn
slice, yellow =
slice and green
slice slidersto
slice through the
volume in all
three anatomical
directions

~ Data Probe

L
E
B
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3D Interactive exploration of
thoraco-abdominal CT data
using Volume Rendering
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Volume Rendering

®

800 3D Slicer 4.2.0-rc1-2012-10-28
Eile Edit View Help

£a 'Modules: . |® Volume Rendering = QO I9O @@ ~ H|t 8 & R+
e IS

@ 3DSlicer

» Help & Acknowledgement

«Volume: [6: CT_Thorax_Abdomen
» Inputs

~ Display
Preset: Select a Preset B
Shift:

Select thé m—o“dulél Volume
Rendering in the modules
menu

~ Data Probe

wnr
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Volume Rendering

3D Slicer 4.2.0-rc1-2012-10-28

®

8006
File Edit View Help
g |Modules: .| ® Volume Rendering " QOIPO @@ < | EHIt -8 w fal b~

CEY

!B= 30Slicer
-

» Help & Acknowledgement

\
«Volume: [6: CT_Thorax_Abdomen 3
» Inputs \

\

~ Display
Preset: Select a Preset s
Shift:

Select thé vdlﬁme
6:CT_Thorax_Abdomen

~ Data Probe

wnr
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Volume Rendering

6006 3D Slicer 4.3.1

& ) fa IModues: . [@VoumeRendering ¢/ ™ Q O |fo k GHEIE t- 8 w R +-@@

@ 3DSlicer

» Help &

®

% Volume: |6: CT_Thorax_Abdomen

» Inputs

Preset:
Shift:
Crop:
Rendering:

>

Slide 41



Volume Rendering

800 2.0-rc1-2012- 8
File Edit View Help
# & Modules: . |®Volume Rendering = Q. PO« ~ %
ox M1 &
@ Slicer

» Help & Acknowledgement

«~Volume: |6: CT_Thorax_Abdomen
» Inputs

~ Display

Preset: @ CT-Cardiac3

Shift:

Crop: Enable <+ Di Ol |&Fit to Volume

Rendering:|NCI GPU Ray Casting

Select the Rendering VTK
CPU Ray Casting, and
click on the eye icon in the
Volume tab to display the
Volume rendered volume
in the 3D viewer
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Volume Rendering

3D Slicer 4.2.0-rc1-2012-10-28

®

File Edit View Help
# Modules: . @ Volume Rendering =00 19O «@ <« |EHlt- e Fa

Q 3DSlicer

» Help & Acknowledgement

= \olume: |6: CT_Thorax_Abdomen i
» Inputs

~ Display

Preset: @ CT-Cardiac3 B
Shift:
Crop: Enable «Display ROl |+ Fit to Volume|
Rendering:NCI GPU Ray Casting C

» Advanced...

Slicer displays the 3D
rendered volume of the

CT _Thorax_Abdomen dataset
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Volume Rendering

800 3D Slicer 4.2.0-rc1-2012-10-28
File Edit View Help
ga g /Modules: . ®Volume Rendering (= Q. 0

e® b

PO ed v t @ A R

E 3DSlicer

» Help & Acknowledgement

#\Volume: 6: CT_Thorax_Abdomen ¢
» Inputs

~ Displa

- @ CT-Cardiac3 o
Shift: — :
Crop: v Enable = Display ROl | #Fit to Volume
gndering: NCI GPU Ray Casting E

Move the Shift slider

toward the right, to

shift the transfer

function and display
_ the aorta
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Volume Rendering

8 00 3D Slicer 4.2.0

File Edit View Help

@ Modules: \‘[.VulumeRendering ¢‘ - 0 o a 56 L a 7.

e @i
@ 3DSlicer
o

» Help & Acknowledgement

tvkb&v.é?‘v

+# Volume: [6: CT_Thorax_Abdamen

|
|
¥ Inputs ‘
|

¥ Display

Preset: ‘ @ CT-Cardiac3 3 ]
Shift: E

Crop: Enable 4. Display ROl l @Frl to Volume

Rendering: | VTK CPU Ray Casting )

> Advanced... ‘

The volume rendered image
of the aorta and rib cage
appears in the 3D viewer
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Volume Rendering

8 00 3D Slicer 4.2.0

®

lle Edit View Help

Click on the eye icon —_—
In the red viewer to
turn off the visibility of
the anatomical slices

in the 3D viewer
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Volume Rendering

Use the mouse in the -
3D window to rotate
the volume rendered

Image

00 Slicer 4.2.0-rc1-2012-10-28

I |®

ile Edit View Help

B

a®

Q 30Slicer

~ Data Probe

L
F
B

& Modules: . | ®Volume Rendering =009 e«@ 2« | H|t-8 A
1@
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Volume Rendering

806 3D Slicer 4.2.0-rc1-2012-10-28

File Edit View Help

ga 2 2 Modules: . |® Volume Rendering "0 0190 &« @ < t-8 A
2® b

@ 3DSlicer

» Help & Acknowledgement

= Volume: |6: CT_Thorax_Abdomen
2 » Inputs

~ Display

Preset: @ CT-Cardiac3
Shift:
Crop: Enable < Display ROl | #Fit to Volume |
Rendering: NCI GPU Ray Casting s
» Advanced...

Click on the eye icon

In the volume

rendering panel to
remove the volume
rendered image from

the 3D viewer
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Volume Rendering

800 3D Slicer 4.2.0
File Edit View Help
7?@@7Wdules:w\[.\folumeRendering ¢l-,°v07°6 E e 77"7! =% Ehv’.é,v

@ 3DSlicer

) Help & Acknawledgement ]

4. Volume: |6: CT_Thorax_Abdomen s

J
» Inputs J
¥ Display ]
Preset: [ @ CT-Cardiac3 i ]
Shift: &
Crop: 17 Enable +. Display ROI
Rendering: [VTK CPU Ray Casting 3

» Advanced...
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Volume Rendering

8 00 . — . — . — . — . 3D Slicer 4.2.0 . "

File Edit View Help

’@ @ Modules: .| @ Volume Rendering tl - ev o ‘ 0 & @ 7. t v @ & Ehv E
ax B

@ 30Slicer

» Help & A

4 Volume: | 6: CT_Thorax_Abdomen

» Inputs

The region of interest
appears in the 3DViewer
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Volume Rendering

86006

Fle Edi He
@ Modules: © Volume Rendering 4| == O ) W D @ E 7 t~ e 5o
ex gl

Turn on the visibility of the
grayscale images in to the
3D Viewer, and position the
ROI around the left and right
Kidneys using the ROI
controls in the 2D
anatomical views and in the

3D viewer Slide 51



Volume Rendering

/

600 3D Slicer 4.2.0
File Edit View Help

&a @ | Modues: . | @ Volume Rendering B - 0‘ QP O @ Z
18

B®
@ 3DSlicer

» Help & Acknowledgement

% Volume: |6: CT_Thorax_Abdomen
» Inputs

“

¥ Display

Preset: @ CT-Cardiac3 3 ]
Shift: g
Crop: | Enable & Display ROI
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Volume Rendering

800 3D Slicer 4.2.0

File Edit View Help
@ Modules: ;;‘.Vo\umeRendering ¢‘ -‘ Qv o a Q % E Z t - B 5 ghv «%.v
B® 1 [
@ 3DSlicer
vl
P Help & Acknowledgement

4 Volume: | 6: CT_Thorax_Abdomen

+ Enable isplay ROI ‘ {E-Fit to Volume ‘

Slicer displays the volume
rendered image of the left
Kidney
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Volume Rendering

3D Slicer 4.2.0

8 0 O
File Edit View Help

@ Modules: ,,‘.Volumenenderir\g C‘ -v ov Q a 0 L E 7 t~ =Y Ehv *‘i‘"
18

@®
@ 3DSlicer
>

» Help & Acknowledgement

|
@ Volume: [g: CT_Thorax_Abdomen 2]
J
J

j e
~ Display
- Y @ == R -66.37
p .

Preset: [.cT—Cardiac:i J ‘ L
¥, ! Wt
. £

Shift:
£+ Fit to Volume

Crop: | Enable 8 Display ROI

Rendering: | VTK CPU Ray Casting > J

» Advanced... ]

Extend the ROl to the
right kidney
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Volume Rendering

00 1
FEile Edit View Help
ga & 2 Modules: . ®Volume Rendering =0 Q0 9O e« 2 Bt~ e Fa |4~

es @1 E

» Help & Acknowledgement

= Volume: |6: CT_Thorax_Abdomen
» Inputs

~ Display
Preset: @ CT-Cardiac3
Shift:

Crop: v Enable = Display ROl |#Fit to Volume
Rendering: NCI GPU Ray Casting Z
» Advanced...

Slicer displays the
cropped volume rendered
images showing the left
and right kidney

F
B
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N Volume Rendering

» Help & Acknowledgement

=\Volume: 6: CT_Thorax_Abdomen

» Inputs

~ Display

Preset: @ CT-Cardiac3 o
Shift:
Crop: v Enable « Display ROl | Fit to Volume |
Rendering: NCI GPU Ray Casting g )
» Advanced...

Click on File>Close to
close the scene

Click on Slicer->Exit to
quit Slicer

E
B

8006 2.0-rc1-2012-10-28

File Edit View Help

ga Modules: . |®Volume Rendering = Q09O ed s tv B A R
EEl
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Volume Rendering

30 Slicer 43:1
/ %a |Modules: . |® Volume Rendering = QO f &@ B Y
@® 1
-
:

@ 30Slicer
4

> Help & Acknowledgement

®

# Volume: \s; CT_Thorax_Abdomen

* Inputs
~ Display
Preset: | @ CT-Cardiac3 S
Shift: 0
Crop: ¥ Enable # Display ROI E-Fit to Volume

ing: [VTK CPU Ray Casting ¢)
» Advanced...

& Some data have been modified. Do you want to save
them before exit?

Exit (discard modifications) || Cancel exit

Select Exit (discard
modifications)

~ Data Probe
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3D visualization of surface
models of the brain
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ﬁ' 3D Data Loading and Visualization

* This tutorial is a short introduction to the
advanced 3D visualization capabilities
Slicer

» The Slicer4 Minute dataset is composed of an
MR scan of the brain and 3D surface
reconstructions of anatomical structures.

* The data are part of the SPL-PNL Brain Atlas
developed by Talos, Jakab, Kikinis et al. The
atlas is available at:

http://www.spl.harvard.edu/publications/item/view/2037
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eo0o 3D Slicer 4.3.1
ga 28 & Modues: . [ Welcome toSlicer (™ QO R &@H t - o Fa, -@e
e® 1

Welcome

(Si5a, Load DICOM Data ( (5 Load Data

4 Customize Slicer ( © Download sample Data

~ Feedback
- Share your stories with us and let us know about how 3D Slicer has enabled your research.

We are always interested in improving 3D Slicer, and every submission will be carefully read.

See more at http://goo.gl/6BvcHm.

> About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

> Acknowledgment

To start Slicer, select Start > Programs—-> Slicer4-3.1 (win64)

Q
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Slicer4 Minute Tutorial: Viewing the Scene

3D Slicer 4.3

& |Modules: © Models il O O_ o ok @ fo o,

-ge

30Slicer

*» Help & Acknowledgement

Include Fibers \ Scroll to.... L || &

|
|
|
Scene

~ Information
Surface Area: 5

Volume: Date Modified

Today 7:10 PM
(3 Quantitativelmaging_Sunday_Dec1_2013 Today 7:05 PM Folder
(3 dicom-data Today 9:25 PM Folder
{1 3DVisualization_Tuesday_Dec3 2013 Today 7:06 PM --  Folder

Number of Points:

Number of Cells:

12 » [ dicom-database Nov 1, 2012 8:23 PM - Folder
i - » (1 dataset_CT-Chest Today 7:06 PM -~ Folder
Number of Points Scalars: -
© § Sealars » (1 dataser3_CT-Liver Today 7:06 PM -~ Folder
Number of Cells Scalars: = v [ dataset2_MR-Head Today 9:52 PM — Folder
MRHead_Scene.mrb Today 9:52 PM 21.5MB Document
Filename: (2] dataset1_CT-Thorax-Abdomen Today 7:06 PM - Folder
\ ~ Display
1 of 10 selected, 27.13 GB available
Visible:
Clip:

Slice Intersections Visible:

Slice Intersections Thickness:

Open the directory dataset2_ Head located in
C:/3DSlicerData_RSNA2013/3DVisualizationDICOM_Tuesday Dec3

Drag and drop the file Head_Scene.mrb into Slicer




Slicer4 Minute Tutorial: Viewing the Scene

3D Slicer 4.3.1

teE - @P

ga & 'Modules: . | © Models it G. Ov o ik @

@®

r\ 30Slicer
-

» Help & Acknowledgement

Include Fibers Scroll to... ‘ x ‘ il

Scene

600 Add data into the scene

Choose Directory to Add\ Choose File(s) to Add Show Options

v File Description
¥ ..._Tuesday_Dec3_2013/dataset2_MR-Head/MRHead_Scene.mrb \MRB Slicer Data Bundle *

~ Information

Surface Area:

Name Date Modified

Volume:
> [ zip Today 7:10 PM

[ellellelle]

Number of Points: » (1] Quantitativelmaging_Sunday_Dec1_2013 Today 7:05 PM - Folder
> [ dicom-data Today 9:25 PM -~ Folder
Number of Cells: ¥ [ 3DVisualization_Tuesday_Dec3_2013 Today 7:06 PM -~ Folder

» [ dicom-database Nov 1, 2012 8:23 PM -~ Folder
> [ dataset4_CT-Chest Today 7:06 PM -~ Folder
» [ dataser3_CT-Liver Today 7:06 PM

Number of Points Scalars: E

Number of Cells Scalars: E v [ dataset2_MR-Head Today 9:52 PM
B MRHead_Scene.mrb Today 9:52 PM
Filename: [ L Reset » [ dataset1_CT-Thorax-Abdomen Today 7:06 PM Folder
~ Display
1 of 10 selected, 27.13 GB available
Visible:

lick on OK to load the file MRHead_ Scene.mrb into Slicer

L \
F
B

Q
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®

Slicer4 Minute Tutorial: Viewing the Scene

= 0 Q.
®

Welcome

PO ad 2 o HI LB @ B+~
® HE

When the scene is finished loading,
Slicer displays:

*a 3D model of the head in the 3D
Viewer, and

*anatomical MR slices of the
brain in the 2D Slice Viewers.

kkkk
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Slicer4 Minute Tutorial: Exploring Slicer’ s functionality

806

Flle Edit View Help

ACPC Transform
Add Scalar Volumes

To access the Models -

module, browse
through the list of

modules.

& |Modules: “:, [\ Welcome to Siicer 2y ::::;amj‘s
AllasTests
# Annotations BSpline Deformable Registration
3DSlicer A Data BSpline to deformation field
& DicoM @ Cameras
7 Editor Cast Scalar Volume
We | COTe toces g:angeTraCker
arting,
#a Scene Views @ffEckerBoard Filter
4 Transforms = oo
gty Load DICOM D”%! View Conizglipes Create a DICOM Series
Customize Slicer | 9/ Rendering @ Crop Volume
j @ Volumes Curvature Anisotropic Diffusion
2\ Welcome to Slicer  Data
.| DataProbe
.| Demon Registration (BRAINS)
—— | Informatics »| & DICOM
Registration »|  DICOM to NRRD Converter
Segmentation ,|  Diffusion Tensor Scalar Measurements
Quantfication )| Diffusion Weighted Volume Masking
| Diffusion ,|  DTIChallengeExplorer
GT ,|  Dllexport
1 Fitering ,|  DTlimport
3 Surface Models »|  DWI Joint Rician LMMSE Filter
Converters »|  DWIRician LMMISE Fitter
_ | Endoscopy ,|  DWito DTI Estimation
Uities »|  DWIto Full Brain Tractography
Developer Tools ,|  DWIUnbiased Non Local Means Filter
Legacy »| ~ Editor
Testing » EMSegment Command-ine
Workin Progress | EMSegmenter with Atias
[} without Atlas
Endoscopy
Event Broker

~ Data Probe

R

Execution Model Tour

Expert Automated Registration
Extract Skeleton
fiber_visibility_crash2438
Fiducial Registration
Foreground masking (BRAINS)
Gaussian Blur Image Filter
General Registration (BRAINS)
Gradient Anisotropic Diffusion
Grayscale Fill Hole Image Filter
Grayscale Grind Peak Image Filter
Grayscale Model Maker
Histogram Matching

Image Label Combine

Intensity Difference Change Detection (FAST)

Label Map Smoothing
Label Statistics
labelToggleBug2049

Linear Registration
Mask Scalar Volume
Median Image Filter
Merge Models
Model Maker
Model To Label Map
& Models
Multiply Scalar Volumes
MultiVolumeExplorer
MultiVolumelmporter
N4ITK MRI Bias correction
3€ OpenlGTLinkIF
Orient Scalar Volume
Otsu Threshold Image Filter
Otsu Threshold Segmentation
Performance Tests
PET Standard Uptake Value Computation
Probe Volume With Model
@ Reformat
RegAladin
Resample DTI Volume
Resample Image (BRAINS)
Resample Scalar Volume
Resample Scalar/Vector/DWI Volume
Rigid Registration
Robust Muliresolution Affine Registration
Robust Statistics Segmenter
RSNA2012ProstateDemo
RSNA2012Quant
RSNA2012Vis
B sample Data
Scene Import (Issue 2428)
Scene Views
SelfTests
Simple Region Growing Segmentation
SiiceLinkLogic
SiiceraMinute
slicerCloseCrashBug2590
Subtract Scalar Volumes
Threshold Scalar Volume
Tractography Display
Tractography Interactive Seeding
Tractography Label Map Seeding
Transform MRML Files to New EMSegmenter Standard
< Transforms
Vector Demon Registration (BRAINS)
Vector to Scalar Volume
View Controllers
ViewControllers Slice Interpolation Bug 1926
® Volume Rendering
@ Volumes
Voting Binary Hole Fillng Image Filter
WebGL Export
2\ Welcome to Slicer

¥
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Slicer4 Minute Tutorial: Switching to the Models Module

e fON W/

®

3D Slicer 4.0.gamma-2ZUL1-11-14
& & |Modules: . [@ Models = Q0O I ® @ & §HE «

ex [l
@ 3DSlicer

| » Help & Acknowledgement 1|
= Scene

= hemispheric_white_matter.vtk 1.00
» left_eyeball.vtk H 100
» optic_chiasm.vtk 1.00
» optic_nerve_L.vtk 1.00
= optic_nerve_R.vtk 1.00
= optic_tract_L.vtk 1.00
» optic_tract_R.vtk 1.00
= right_eyeball.vtk W 1.00
» Skin.vtk 1.00
= skull_bone.vtk 1.00

| Information

|~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:

v

|~ Data Probe

wmrr



Slicer4 Minute Tutorial: Basic 3D Interaction

®

e @l W) 3D Slicer 4.Uu.gamma-ZULl1-11-14

& % [Modules: . |@ Models = 0O IO @« &4 §E 2 [F‘ 4 v Persistent Ao R | 4

@ 3DSlicer
v

| » Help & Acknowledgement

- Scene
B V) 4 1.00
Position the mouse - 1;§§
in the 3D Viewer. 1;§§
ot
1.00

Hold down the left

mouse button and
drag to rotate the

model.

wmrr




Slicer4 Minute Tutorial: Viewing Slices in the 3D Viewer

®

e @ ) 3D dlicer 4.Uu.gamma-ZUll-11-14

@ & |Modules: . |@ Models \- COINMO® &« 4§ 2 H m t v Persistent | @ Ao Fa | 4~
B® FIRI L] .00
olm @A o)m
@ 3oslicer : 1001 )@@ None 2]
@ g “ g8 |None B
|» Help & Acknowledgement E|
[:|grayscale

= Scene
= hemispheric_white_matter.vtk
= left_eyeball.vtk

Click on the Slice Visibility
o icon

||
Sl
88888888&8

to display the Axial Slice in
the 3D Viewer

wmr

WLV I £=£V 10 oulyival rialiiily Lavuiatul y, AN INU<T v17s



Slicer4 Minute Tutorial: 3D Visualization

Slicer adds a view of
the Axial slice in the
3D View.
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Slicer4 Minute Tutorial: Viewing Slices in the 3D Viewer

®

e @ W/ 3U Slicer 4.Uu.gamma-ZUL1-11-14
@ & |Modules: . |@ Models ‘\ 00N ® e AP HE 2 H D t v iPersistent | @ S o ﬁgv
CE] 0
o [» \Ax|a| 3 Q-
\@ 3DSlicer [l o‘ ,‘ s NOI’184

- & |None
|» Help & Acknowledgement b ﬁ
! E| B | grayscale
= Scene
= hemispheric_white_matter.vtk
= left_eyeball.vtk [ |

Click on the layout menu in
the toolbar, and select the =

Conventional layout ¥

[~ Display
Visible:

EEEEEEEEEE

Selected:

Clip:

Slice Intersections Visible:
v

|~ Data Probe

L
F
B

WLV I £=£V 10 oulyival rialiiily Lavuiatul y, AN INIU<T VI



®

Slicer4 Minute Tutorial: 3D Visualization

Select the Skin.vtk

Change the opacity of the model from

1.0 to 0.0.

» Help & Acknowledgement

ne
# hemisphel hite_matter.vtk 1.00
* left_eye M 100
* optic_ Vi 1.00
 optic_n¢ i 1.00
* optic_ne WV 1.00
® optic_tract_L.vtk 1.00
# optic_tract_R.vtk 1.00
# right_eyeball. vtk B 100
# skul_bone.vtk 1.00
» Informati
¥ Display
Visible: v
Selected:
Clip:
Slice Intersection: ibl
W Matasialnes,
Zolor:
dpacity: _— ‘1.00 B
\mbient: (000 2] [

CO IO & 2 @& ~ ‘E‘tvp sssss et | @ e S,

4

i v

¥
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Slicer4 Minute Tutorial: 3D Visualization

®

The model of the skull bc_)ne: m00i0® e s®@ ¢ EE & i
and eyeballs become visible " [
through the model of the skinin

the 3D viewer.

(skin model opacity = 0.5) -

Clip:

Slice Intersections Visible:
v Material Properties

Color:

Ambient: |00 (3] |~
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®

Slicer4 Minute Tutorial: 3D Visualization

The model of the skin becomes
invisible in the 3D viewer.

(skin model opacity = 0.0)
(skull model opacity = 1.0)

# skull_bone.vtk

» Information

¥ Display

Visible:
Selected:
Clip:

Slice Intersecti
¥ Material Properties

Color:
7 Ta
Opadity: _— ‘ 0.00 [

Ambient:

Fva‘) QQ%A@E/ ;t' Persistent

Slide 72
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Slicer4 Minute Tutorial: 3D Visualization

®

Click on the Slice

Visibility
icon in the Green Slice
Viewer A

to display the Coronal
Slice in the 3D Viewer.

» Information

¥ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
¥ Material Properties

Color: O

Opadity:
Ambient:
¥ Data Probe

L
E
B
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Slicer4 Minute Tutorial: 3D Visualization

. | B i)
The Axial and Coronal | 7 B —

. . . | :-,0,\) DO s AP Hd ‘O‘t' Persistent H";h. v
Slices are displayed in | -<p:
the 3D Viewer. B

T
0
@
I
5
n

999999399
o o

Slice Intersections Visible:
¥ Material Properties

Color:

Opacity: (o E

Ambient: === It
¥ Data Probe

L
F
B
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Slicer4 Minute Tutorial: 3D Visualization

Select the 3D model skull_bone.vtk in - — —
the Model Hierarchy and turn on the LI & b v st | @ A Fa | b~

Clipping option.

=} Scene
 hemisy ic_white_matter. v 1.00
® left_e B 100
* optic, v 1.00
* o Vi 1.00
= o v 1.00
& optic_tract_L.vi 1.00
® optic_tract_R.vi 1.00
# right_eyeball.v M 100
- Skin.v 0.00
>
» Information |
¥ Display |
Visible: v
Selected
H Clip: v
Slice Intersections Visible:
¥ Material Properties
Color:
Opacity: | 100 |5
Ambient: 000 %
¥ Data Probe
L
F
B
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®

Slicer4 Minute Tutorial: 3D Visualization

B rOWS e th ro u g h 8.0.gamma-2011-11-14

w Help

the coronal T N—C
slices to expose s

the 3D model of [

the white matter, ;-
and the leftand [ ¢
right optic
nerves. -,
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Slicer4 Minute Tutorial: 3D Visualization

®

Now make the skull invisible.
T ek (@R ™ O QIO e s §HE 2 B E‘t' Persistent fo Fo | 4~

!‘; 3DSlicer
wy

» Help & Acknowledgement li
|
"= Scene
# hemispheric_white_matter.vtk 1.00
# |eft_eyeball.vtk B 100
# optic_chiasm.vtk 1.00
® optic_nerve_L.vtk 1.00
# optic_nerve_R.vtk 1.00
 optic_tract_L.vtk 1.00
® optic_tract_R.vtk 1.00
# right_eyeball.vtk M 100
L+ skin.vtk 0.00
» Information |
¥ Display
Visible: [ |
Selected:
Clip: v
Slice Intersections Visible:
¥ Material Properties
Color: ( |
Opacity: 100 3]
Ambient: i———————— 1) ':: -
¥ Data Probe
L
F
B
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Slicer4 Minute Tutorial: 3D Visualization

®

Scroll the Coronal Slices to display the

(2] E ]

hemispheric white matter model in the[,>.0 = © = + @ 2 - & ¢ t- = & « -

1

context of the image data in the 3D
Viewer.

[ |
7 5
29
i - /.‘ 4
3 S
1bf
U

N\
X A ¢
- ) (h F —
1.00 - S e
1.00 - %
.00 - —
1.00
M 100
0.00
0.00
¥ Display |
Visible: v
Selected:
Clip: v
Slice Intersections Visible:
¥ Material Properties
Color:
Opadity: 0.00 %
Ambient: 0‘00% b
¥ Data Probe
L
F
B

e v
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Slicer4 Minute Tutorial: 3D Visualization

Select the hemispheric white matter model called
hemispheric_white _matter.vtk

Turn off its visibility.

= Scene
L] ® he 100 |
* e B 100
> 1.00;
ol 1.00;
ol 1.00;
- 1.00
- 100
- B 100
> 0.00
# skull_bone.vtk 0.00
» Information
¥ Display
H Visible:
Selected:
Clip:
Slice I ection: bl
¥ Material Properties
Color:
Opacity: 1.00 |4
Ambient: 0.00 (51 (v
¥ Data Probe
L
E
B
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Slicer4 Minute Tutorial: 3D Visualization

|

Slicer displays the optic nerve,
optic chiasm and optic tracts
overlaid on the MR images of
the brain.

®
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Slicer4 Minute Tutorial: 3D Visualization: Zoom the view

®

File Edit View Help

/£ 3D Slicer 40.gamma-2011-11-14 ==
92 B | Modues: @ Models s - G. IO & A G 2 | 4 v persistent R So, -

Windows/Linux users: Position the
mouse in the 3D Viewer, hold down
the right mouse button and move| ..

the mouse down to zoom in.

puC_woTt L
# optic_tract_R.vtk 1.00
# right_eyeball.vtk M 100
® Skin.vtk

Mac users: Position the mouse in|
the 3D Viewer, hold down the apple
button and the mouse button and

move the mouse down to zoom in_

(or use two fingers on the touch™ " -
pad).

E
B

©2012-2013 Surgical Planning Laboratory, ARR Slide 81




®

Slicer4 Minute Tutorial: 3D Visualization: Zoom the view

@ 3D Slicer 40.gamma-2011-11-14

O | B |3

File Edit View Help

FaN

@ 3DSlicer

» Help & Acknowledgement

Slicer displays a closer; ===~

view of 3D anatomical -
. it_eyeball.vtk B 100
structures overlaid on 2D - o

MR slices:

Visible:
Selected:
Clip:
Slice Intersections Visible:
¥ Material Properties

Color:

Opacity: e | 1,00 |5

Lt 5 Modues: @ Models s _v G- J Q (48] G A @ E 7 ; t v || Persistent o Ehv

Ambient: i—-———" I 1=k

¥ Data Probe

L
E
B

v
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®

£a Add Data %0

Close the existing scene and all its data

Select File->Close |
Scene :

Clip:
Slice Intersections Visible:

Slice Intersections Thickness: 1 px

This removes any dataset
previously loaded into Slicer.

Select Slicer->Quit to exit the
software

& Boicom EK)

B Download Sample Data

2%

1.00
1.00
1.00
1.00
1.00
100

Do .

—
B

ex M1k

¢HE B

t- @ e R

@e
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N Overview

Part lll: 3D interactive exploration of the anatomy
- Exploration of the Segments of the liver
- Exploration of the Segments of the lung
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Part Il:

Interactive 3D Visualization
of the segments of the liver

©2012-2013 Surgical Planning Laboratory, ARR Slide 85



Anatomy of the liver

Right Right Left Left
posterior anterior medial lateral
section section section section

Right hepatic vein

Umbilical vein
(remnant)

Hepatic duct
Inferior vena cava

Cystic

Hepatic artery
duct

Portal vein

Gall bladder Bile duct
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‘ﬁb Liver dataset

The liver dataset is

a contrast-enhanced CT
abdominal scan of a
healthy 36 year-old male.
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3D segments of the liver

®

~ __ SegmentlVa

''''''

Segment VI Segment Il

Segment VI - Segmentlil

Segment V ~ Segment [Vb .
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ﬁ' 3D segments of the liver

|
Segment | | Segment |

Segment Il
Segment Vb Ve | *=" Segment VI

| ==

3 S_ngment V
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Liver vasculature

Middle Left portal .
AERENT Vel vein = Left hepatic

q T vein
Rig ht pOrtaI | : ' ) S - ~‘:- \.- .I‘.I_-‘_::‘-""'/:'.'; :,—i:’,{( \::ﬂf; - | "i
i SRR SR & Caudate vein | =

Vel gk iy o h “— ‘

——
—

o

e

Main portal

Right hepatic gt
vein
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Loading the Liver Scene

eeeeeeeeeeeeeeeeeeeee

Browse to the directory
C:\3DSlicerData_RSNA2013\3DVisualizationDICOM_Tuesday Dec3

Select the directory dataset3 Liver
Drag and drop the file LiverSegments_Scene.mrb into Slicer

Click on OK to load the scene into Slicer
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Loading the Liver Scene

3D Slicer 4.3.1
ga 2 & IModules: . ©Models = Q0O Rk H E t-E8 ™R +-@@
B® 1
\@ 3DSlicer
Include Fibers «. Scroll to...
Scene
|
6006 Add data into the scene
Choose Directory to Add [Choose File(s) to Addl Show Options
[ » Information v File Description
¥ ..ation_Tuesday_Dec3_2013/dataset3_CT-Liver/LiverSegments_Scene.mrml| lMRMLScene 3
| ~ Display
Visible:
Clip:

Slice Intersections Visible:

Slice Intersections Thickness:

Color: Eaiiiid

LAHHI

'; Reset x Cancel
Opacity:
Edge Visibility:
Edge Color: N #000000

~ Data Probe: /Users/spujol/workshop/R...

L Click on OK to load the scene into Slicer
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Liver Segments Scene

®

The elements of the scene appear in the Viewer
\@msucer S

Welcome
s, Load DICOM Data | o Load Data |
Gaw Load Data || @ D: Data |
» About

> The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

~ Data Probe

wmr
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o) 3D models of the liver

~ Segment |Va

-----

Segment VI Segment Il

Segment VI ~ SegmentlIl

Segment V ~ Segment [Vb =
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]
|
i

.ﬁb 3D models of the liver

Segment |

Segment ’I Segment VII

Segment | ‘
Segment IVb |y | *~ Segment VI

: -

3 S—e;gment V
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oi¢? 3D models of the liver

Middle Left portal § E i

AEDENE HEll , W= |eft hepatic
Right portal F oy s 50 00 o o *
vein R W ﬁl CaudaE/ein I R

Main portal

Right hepatic gati
vein -l

©2012-2013 Surgical Planning Laboratory, ARR Slide 96



ﬁ' 3D Exploration of Liver Segments

Example:
What organ abuts the
left-most margin of
segment Il in this
patient ?
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3D Exploration of Liver Segments

3D

,,

@ # MByes: JM.QO DO ws9HE
ex [l

@BDSIicer

[» Help & Acknowledgement

®

D]

= Scene

= Liver Structures Models

= Vessels

» [VC [ |
= MainPortalVein
= LeftHepaticVein_and_Branches M
« MiddleHepaticVein_and_Bran... |
= RightHepaticVein_and_Branc...
= LeftPortalVein_and_Branches
= RightPortalVein_and_Branches
= CaudateVeins
gments
= LiverSegment_lI
= LiverSegment_|II
» LiverSegment_IVa
» LiverSegment_IVb
» LiverSegment_|
= LiverSegment_VIII
= LiverSegmentV
LiverSegmentVI
LiverSegmentVIl

EEEEEEEE

EEEETEE
EEEEEEEEE

| » Informg8lon

[~ Display
Visible:
Selected:
Clip:
Sliceg'

_ Select the module Models
. Click on the Liver Structures Models Hierarchy

= SRV an7e
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3D Exploration of Liver Segments

8006 3D Slicer 4.0.gamma-2011-11-24

& & Modules: . [@ Models " 00N @« A 9@ -E ‘E‘ 4~
1

@®
@ 3DSlicer

» Help & Acknowledgement

> @ R R | 4~

I»)

= Scene
= Liver Structures Models
= Vessels
= [VC | |
= MainPortalVein
» LeftHepaticVein_and_Branches |
= MiddleHepaticVein_and_Bran... |
= RightHepaticVein_and_Branc...
= LeftPortalVein_and_Branches
= RightPortalVein_and_Branches

Sobobodoatot
88888888

Nerpegmomsl] 1] i

= LiverSegment_IVa B 1.00
= LiverSegment_IVb W 100
= LiverSegment_| 1.00
= LiverSegment_VIII B 1.00
= LiverSegmentV | 1.00
= LiverSegmentVI W 1.00
= LiverSegmentVIl o 1.00

» Information

~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
v Material Properties

Select the model Liver_Segment |l
Turn on/off its visibility to locate
— it in the 3D viewer. —
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3D Exploration of Liver Segments

®

8no 3D Slicer 4.0.gamma-2011-11-24
% & [Modules: . |@Models = QOO @« A @ H » o 4~
1
r‘\ 3DSlicer

4
» Help & Acknowledgement

Position the mouse in
the 3D Viewer, hold
down the left mouse
button and drag to &\ /e
orient the 3D model to N — 4
a superior view. G e —

L
F
B
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3D Exploration of Liver Segments

e 0o 3D Slicer 4.0.gamma-2011-11-24

@ & |Modules: . [@Models OO0 IO & A@Ed PN B4 » Ao Ra v

Q 3DSlicer

» Help & Acknowledgement

= Scene
= Liver Structures Models
= Vessels

IVC | 10

MainPortalVein 1.0

LeftHepaticVein_and_Branches 1.0

MiddleHepaticVein_and_Bran... [ 1.0

RightHepaticVein_and_Branc... } 8
1.0
1.0

9

4999

» LeftPortalVein_and_Branches
= RightPortalVein_and_Branches
» CaudateVeins

g

[ellot=lot=ToT =]

= LiverSegment_IIl
» LiverSegment_IVa
» LiverSegment_IVb
» LiverSegment_|
= LiverSegment_VIII
= LiverSegmentV
= LiverSegmentVI
= LiverSegmentVII

EEETEN
[elelololotatal
[SIStStSISIStSts!

» Information |

~ Display |
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: &
~ Data Probe

What organ abuts the left-
most margin of segment Il

@wmr
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®

3D Exploration of Liver Segments

e 0o 3D Slicer 4.0.gar
& & |Modules: . [@Models Q0 IN® e 4 @H

Question 1:

mma-2011-11-24
» ol ¢~

What organ abuts the left-

most margin of segment Il
in this patient?

Answer 1: Stomach

lice Lnter_sections V_isnble:
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3D Exploration of Liver Segments

XX 3D Slicer 4.0.gamma-2011-11-24
@ & |Modules: . [@ Models "m0 IO e 42 @E » PRI Y » fa fa, -
1
eO®

®

Question 2:

Which segment would
most likely be affected by
an aggressive tumor
invading locally from the

right adrenal gland ?

w i
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3D Exploratlon of leer Segments

8 0o 0.gamma-.

@ & |Modules: . [@Models :—Q\){DO@K\WQ I,O't
@®

®

Question 2:

Which segment would
most likely be affected by
an aggressive tumor
invading locally from the
right adrenal gland ? —
Answer 2: Segment VI

00000000
[slelstetototots]

-e

EEETEE
0000000 Y
[SIStSiStstSIsts|

W

©2012-2013 Surgical Planning Laboratory, ARR Slide 104



‘ﬁ' 3D Exploration of Liver Segments

~ Question 3:

" B \Which vessel separates
Segment Vb and
Segment V?

e
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Middle Hepatic Vein

000 3D Slicer 4.0.gamma-2011-11-24 u
& Modules: . [@Models =0 QI ® @« 4 @& 5\ t- | Mlddle
o= [l
@ 3DSlicer
v

| » Help & Acknowledgement |8
= Scene
= Liver Structures Models

= Vessels
o IVC m 1.00
< MainPortalVein 1.00
< LeftHepaticVein_and_Branches M 1.00
= MiddleHepaticVein_and_Bran... [§ 1.00
< RightHepaticVein_and_Branc... 1.00
< LeftPortalVein_and_Branches 1.00
< RightPortalVein_and_Branches 1.00
« CaudateVeins 1.00

= Segments
< LiverSegment_I|

-
Q9
S

< LiverSegment_llI

< LiverSegment_IVa

LiverSegment_IVb

LiverSegment_|

LiverSeg mentVVI 1l
I

-
LiverSegmentVI|
< LiverSegmentVII

|» Information |

| ~ Display

\liniklA- >

Question 3:
Which vessel separates Segment IVb and Segment V?
Answer 3: The middle hepatic vein

>



Closing the Liver Scene

8eno 3D Slicer 4.0.gamma-2011-11-24

% # |Modules: (@ Models ]-eo DO e@sA@Z - Eelt- > @ A R |4

!" 3pSlicer
4

| » Help & Acknowledgement

= Scene
= Liver Structures Models
ERVZ-INVNIN

< HigntPortalvein_anda_bBranches
< CaudateVeins
= Segments
< LiverSegment_II
< LiverSegment_llI
< LiverSegment_IVa
= LiverSegment IVb
< LiverSegment_|

LiverSegment_ VIII

Liver! egmentVI
LiverSegmentVII

|» Information

| ~ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: [ (]
| ~ Data Probe

wmr
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Interactive 3D Visualization
of the segments of the lungs
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®

Segments of the lung

Segmentation and 3D surface
reconstruction of the lung and
pulmonary vessels

Acknowledgment:

Segmentation of the lung surface and vasculature: Raul
San Jose Estepar, Ph.D., George Washko, M.D., Ed
Silverman, M.D. and James Ross, MSc. Brigham and
Women'’s Hospital (K25 HL104085) and COPDGene (01
HL089897 and U01 HL089856)
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N Segments of the lung

3D parcellation of arteries and veins from

original model of pulmonary vessels
(Kitt Shaffer, M.D., Ph.D. - Sonia Pujol, Ph.D.)

- Right Upper Lobe (RUL)
- RUL Pulmonary Vein
- RUL Anterior Segment
- RUL Apical Segment
- RUL Posterior Segment
- Right Middle Lobe (RML)
- RML Pulmonary Vein 1 & 2
- RML Lateral Segment
-  RML Medial Segment
- nght Lower Lobe (RLL)
RLL Pulmonary Vein 1,2,3
- RLL Anterior Basal Segment
- RLL Medial Basal Segment
- RLL Lateral Basal Segment
©2012-2013 Surgical Planning Laboratory, ARR -  RLL Posterior Basal Segment




Loading the Chest Data Scene

t- B A

% IModules: . |© Models ™ Q. QR &k @ @
ox H1E
Q 3DSlicer

® 0 6

()00 =l ) (5 (5 (2]

‘ * Help & Acknowledgement ‘A

Include Fibers scroll to... IS
Scene

~ Information

Surface Area:
Volume:
= v Tod PM - Folder
Number of Points: N e
B > [ datasetl_CT-Thorax-Abdomen Today7:06PM  --  Folder
Number of Cells:

Number of Points Scalars:

Open the directory
C:\3DSlicerData_ RSNA2013\3DVisualizationDICOM_Tuesday Dec3
Select the subdirectory dataset4 Chest

Drag and drop the file LungSegments_Scene.mrb into Slicer
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Loading the Lung Scene

3D Slicer 4.3.1

LB A R

85 8 & Mowes owoms 5= 0.0 |n & ® @ e

@®

3DSlicer

\ » Help & Acknowledgement

fuuf [imi]

v [

Include Fibers . Scroll to... o

Scene

80060 Add data into the scene
i Fil ion.
Choose Directory to Add | Choose File(s) to Add Show Options Lungse S ce.meb
v File Description
v 3/d 4 CT- ) :
..sday_Dec3_2013/ _CT-Chest/L _Scene.mrb | MRB Slicer Data Bundle Name Date Modified Kind
— > [ zip Today 7:10 PM Folder
~ Information » [ Quantitativelmaging_Sunday_Decl_2013 Today 7:05 PM -~ Folder
—d > [ dicom-data Today 9:25 PM -~ Folder
Surface Area: E v [ 3DVisualization_Tuesday_Dec3_2013 Today 7:06 PM - Folder
» [ dicom-database Nov 1, 2012 8:23 PM -~ Folder
Volume: E v [ dataset4_CT-Chest Today 9:58 PM --  Folder
o [} LungSegments_Scene.mrb Today 9:57 PM 151.9M8  Document
Number of Points: 9 » (] dataser3_CT-Liver Today 7:06 PM - Folder
: E ¥ [ dataser2_MR-Head Today 9:52 PM -~ Folder
Number of Cells: " MRHead_Scene.mrb Today 9:52 PM 21.5MB  Document
» [ dataset]_CT-Thorax-Abdomen Today 7:06 PM Folder
amberf s S L
Number of Cells Scalars: E
L
Filename: L & Reset Fox
\ ~ Display
Visible:
Clip:

Slice Intersections Visible:

Slice Intersections Thickness:

Click on OK to load the file into Slicer
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Loading the Lung Scene

800
% & |Modules: - |Welcome to Slicer =0 QO O

@ 3DSlicer
Welcome

(G, Load DICOM Data | [y Load Data

“0.gamma-2011-11-24

e Load Volume Data || @ Download ple Data

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

» Documentation & Tutorials

» Acknowledgment

~ Data Probe

whnr
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Loading the Lung Scene

800

3D Slicer 4.0.gamma-2011-11-24
2 & [Modules: - |Welcome to Slicer S

d= 00N e s @2 ~EHlelt-
\ansncer
w

e HA
Welcome

( Load DICOM Data || Load Data J
[ Load Volume Data || @ Download

ple Data |

» About

» The Main Window

» Loading and Saving

» Display

» Mouse & Keyboard

Select the module Models from
the modules Menu.

~ Data Probe

W
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ung Segments

& Slicer File Edit View Help GO M D ) & 548PM Q
8006 3D Slicer 4.0.gamma-2011-11-24
& [Modules: . [@Models =00 IO e« A9 HE » @l 4~ > @ A fa | v

e [l

@ 3DSlicer

[» Help & Acknowledgement =

= Scene
» chestCT_lungs
= RightUpperLobe_PulmonaryVein
= RightUpperLobe_PosteriorSegment
= RightUpperLobe_ApicalSegment
= RightUpperLobe_AnteriorSegment
= RightMiddleLobe_PulmonaryVein
= RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddelLobe_PulmonaryVein2
= RightLowerLobe_SuperiorSegment
= RightLowerLobe_PulmonaryVein3
= RightLowerLobe_PulmonaryVein2
= RightLowerLobe_PulmonaryVein1
= RightLowerlLobe_PosteriorBasalSegment
= RightLowerLobeMedialBasalSegmen
= RightLowerLobeAnteriorBasalSegment
= RightLowerLobe_LateralBasalSegment
= RightLowerLobe_PulmonaryVein4

Slicer displays the list of 15
surface models of pulmonary
structures.

ENNEEEEEEEENNEEEE
P e e e e
§8888888888888888%

[» Information

[~ Display

Visible:

Selected:

Clip:

Slice Intersections Visible:
v

Color:
Opacity: [
| ~ Data Probe

wmnr
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Lung Segments — Question 1

@ Slicer File Edit View Help GO MM = ) & 423PM Q
800 BRiSlicendi0icammas2 D114
@ & [Modules: . (@ Models DR 5) {D O @ A @ [ER @ t~

@®

@ 3DSlicer

[» Help & Acknowledgement

= Scene
< chestCT_lungs
= RightUpperLobe_PulmonaryVein
= RightUpperLobe_PosteriorSegment
= RightUpperLobe_ApicalSegment
= RightUpperLobe_AnteriorSegment
= RightMiddleLobe_PulmonaryVein
= RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddelLobe_PulmonaryVein2
- HightLowerLobe,SuFeriorSe ment
= RightLowerLobe_PulmonaryVein3
= RightLowerLobe_PulmonaryVein2
= RightLowerLobe_PulmonaryVein1

thtLowerLobe Posterlor asalSegment

EEEEEEEENNEEEE
8F3883358833585%

[» Information

[~ Display
Visible: v
Selected:
Clip:
Slice Intersections Visible:
v Material Properties

Color: ( []

]
Opacity: 711.00 |

Amhiant: ) nnn i«
|~ Data Probe

T
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Lung Segments — Question 2

@ Slicer File Edit View Help GO M = 4) G 425PM Q
800 3D Slicer 4.0.gamma-2011-11-24

%2 & Modules: - | @ Models

!l; 3pSlicer
4

| » Help & Acknowledgement

= Scene

.. _chestCI_lungs
RightUpperLobe_Pulmo...
RightUpperLobe_Poster.
RightUpperLobe_Apical.
RightUpperLobe_Anteri...
RightMiddleLobe_Pulm...
RightMiddleLobe_Later...
RightMiddleLobeMedial...
RightMiddeLobe_Pulmo.
RightLowerlLobe_Superi.
RightLowerLobe_Pulmo...
RightLowerLobe_Pulmo...
RightLowerLobe_Pulmo...
RightLowerLobe_Poster...
= RightLowerLobeMedial...
= RightLowerLobeAnterior...

9939999999999
ottt
[elelelololololololololololo]e)
[slelslslslolslslolslololalala) A

| » Information

|~ Disolav

Question 2:Which
segment’s vascular
supply is shown at the
arrow?
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Lung Segments — Question 2

@ Slicer File Edit View Help GO M D 4) GF 425PM Q
800 3D Slicer 4.0.gamma-2011-11-24

& & |Modules: . [@Models "0 O INO @si@R » o)t~

@ 3DSlicer
4

| » Help & Acknowledgement

> @ R R4

= Scene

.. _chestCI_lungs

= RightUpperLobe_Pulmo...
= RightUpperLobe_Poster...
= RightUpperLobe_Apical...
= RightUpperLobe_Anteri...
= RightMiddleLobe_Pulm...
= RightMiddleLobe_Later...
= RightMiddleLobeMedial...
= RightMiddeLobe_Pulmo...
= RightLowerLobe_Superi...
= RightLowerLobe_Pulmo...
= RightLowerLobe_Pulmo...
= RightLowerLobe_Pulmo...
= RightLowerLobe_Poster...
= RightLowerLobeMedial...
= RightLowerLobeAnterior...

Question 2:Which segment’s
vascular supply is shown at
the arrow?

Answer 2: Right Upper Lobe
Apical Segment

EEEn

aaaaaaaaaaaaaaafe
[eletotololotototolototoYotote)
[eleleletotelelolotototot ookl ]

©2012-2013 Surgical Planning Laboratory, ARR Slide 118



Lung Segments — Question 3

& # |Modules: —-OO O e s P

@ 3DSlicer

Help & Acknowledgement

= Scene
# chestCT_lungs
- nghtUpperLobe PulmonaryVein
htU Lob

per|
- nghtMlddIeLo ulmonaryVein
» RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddeLobe_PulmonaryVein2
- nghtLowerLobe_Sur)erlorSe ment
= RightLowerLobe_PulmonaryVein3
= RightLowerLobe_PulmonaryVein2
= RightLowerLobe_PulmonaryVein1
- nghtLowerLobe Posterlor asaISe
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Lung Segments — Question 3

8006 3D Slicer 4.0.gamma-2011-
& [Modules: . [@ Models S| -

9®
@ 3DSlicer

» Help & Acknowledgement

= Scene
» chestCT_lungs
» RightUpperLobe_PulmonaryVein
= RightUpperLobe_PosteriorSegment
= RightUpperLobe_ApicalSegment
= RightUpperLobe_AnteriorSegment
= RightMiddleLobe_PulmonaryVein
= RightMiddleLobe_LateralSegment
= RightMiddleLobeMedialSegment
= RightMiddeLobe_PulmonaryVein2
» RightLowerLobe_SuperiorSegment
= RightLowerLobe_PulmonaryVein3
< RightLowerLobe_Pulmonar: \'/ein2
- R e_Pu
< RightLowerLobe_PosteriorBasalSe...
= RightLowerLobeMedialBasalSegmen
» RiahtLowerLobeAnteriorBasalSea. ..

Question 3:Which
segment’s vascular supply
iIs shown at the arrow?
Answer 3: Right Lower
Lobe Pulmonary Vein 1

11-24

D}

[slelelelalalalele).]

bgb'obb‘o'o'obb'—n
S

FQIFGEN _ PN o

8885
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ung Segments — Question 4

@& Slicer File Edit View Help PRl 440PM Q

@ & [Modules: . (@ Models

@ 3DSlicer

[» Help & Acknowledgement
L

»&&v+v

= Scene
= chestCT_lungs
< RightUpperLobe_PulmonaryVein 1l
< RightUpperLobe_PosteriorSegment
< RightUpperLobe_ApicalSegment
< RightUpperLobe_AnteriorSegment
« RightMiddleLobe_PulmonaryVein
< RightMiddleLobe_LateralSegment
< RightMiddleLobeMedialSegment
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Lung Segments — Question 4
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Lung Segments — Question 4
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3D Visualization of DICOM images

 Interactive user-interface to
load and manipulate
greyscale volumes,
labelmaps and 3D models.

» User-defined 3D view of the
anatomy

« 3D Open-source platform for
Linux, Mac and Windows
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3DSlicer website

Search L

3051 A multi-platform, free and open source software package for
DSlicer visualization and medical image computing

Slicer Wiki

About Slicer
»Introduction
»Acknowledgments
»Contact Us

Resources
Download

»For Users

»For Developers
»Commercial Use
*NCIA
»Publication DB
»Image Gallery
»Slicer Community
»Source Code
»Licensing
»Mailing Lists
»Web Archive

4

The community of Slicer developers is proud to announce the release of Slicer 4.2. Find out more...

Webinar: Introduction to Slicer 4.1

Content of this site is Copyright 2012 BWH and 3D Slicer contributors, unless otherwise noted.
Contact webmaster@bwh.harvard.edu for questions about the use of this site's content.
See here for more information about the web infrastructure.
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3DSlicer at RSNA 2013

®

Quantitative Imaging Reading Room Exhibit QIRR 1028

e« Sun. Dec.1-Fri. Dec.6, 8:00-6:00

« 3DSlicer: An Open Source Platform for Segmentation,
Registration, Quantitative Imaging, and 3D Visualization of
Multi-Modal Image Data.

* Sonia Pujol, PhD, Steve Pieper, PhD, Andriy Fedorov, PhD,
Ron Kikinis, MD,
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Additional Related Hands-on courses

®

All courses are in this Advanced Imaging Classroom: S401CD
(except Monday when it is in S401AB)

Sunday 11:00 am — Quantitative Imaging for Medical Research and Practice

Sunday 4:00 pm — Structured Annotation and Image Markup (AIM) Template and Toolsets
(ICIW12)

Monday 4:30 pm — Clinical Trials Software for Clinical Trials and Research (ICIW24)
Wed 10:30 am — Open Access Imaging Data Resources: NIH Cancer Imaging Archive (ICIA41)

Wed 12:30 pm — Correlating Imaging with Human Genomics (ICIA42)
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3DSlicer at RSNA

Sunday, December 1 Monday, December 2 Tuesday, December 3 Wednesday, December 4 Thursday, December 5 Friday, December 6
B ooam: b Siced 8:00am-11:00am: 3D Slicer
Exhibit: Quantitative Imaging Exhibit: Quantitative Imaging
Reading Room. & Reading Room. &
Lakeside Learning Center Lakeside Learning Center
Hall E, Exhibit LL-QRR3007. 8:00am-11:00am: 3D Slicer Hall E, Exhibit LL-QRR3007. !
. 8:00am-12:15pm: 3D Slicer
11:00am-12:30pm: RSNA Exhibit: Quantitative Imaging 12:30pm-2:00pm: RSNA Exhibit: Quantitative Imaging
Refresher Course: "Quantitative Reading Room. & Refresher Course: "3D Interactive! Reading Room. @
Medical Imaging for Clinical Lakeside Learning Center | v, 2117ati0n of DICOM Images || 8:00am-12:15pm: 3D Slicer Lakeside Learning Center
Research and Practice: Hands- Hall E, Exhibit LL-QRR3007. for Radiology Applications: Exhibit: Quantitative Imaging Hall E, Exhibit LL-QRR3007.
on Workshop.” & 12:30pm-1:30pm: Meet-The- Hands-on Workshop." & Reading Room. & e ———
Sonia Pujol, Katarzyna Macura, Experts Session &, 3D Slicer Sonia Pujol, Kitt Shaffer, Ron Lakeside Learning Center Exn.b rpm- : mpl:. ; |0Ier 8:00am-12:45pm: 3D Slicer
Ron Kikinis Exhibit: Quantitative Imaging Kikinis Hall E, Exhibit LL-QRR3007. L 'l-‘Q‘;ﬂI" ; ve TI:Q ng Exhibit: Quantitative Imaging
Room S401CD. - — sacingliiroon Reading Room. &
Lak:;::'::a::’"éfmr [ETDEiE 1:30pm-6:00pm: 3D Slicer EXhibit:| | akeside Learning Center Lakeside Laarning Certer
12:30pm+-1:30pm: Meet-The- Ceaming 12:30pm-1:30pm: Meet-The- || Quantitative Imaging Reading | Hall E, Exhibit LL-QRR3007. ibi
; ’ Hall E, Exhibit LL-QRR3007. Hall E, Exhibit LL-QRR3007.
Experts Session &, 3D Slicer J Experts Session &, 3D Slicer Room. &
Exhibit: Quantitative Imaging  |\4.30pm-6:00pm: 3D Siicer Exhibit:| Exhibit: Quantitative Imaging | Lakeside Learning Center, Hall E, 1:30pm-6:00pm: 3D Slicer Exhibit:
Reading Room. & Qi o Room. & Exhibit LL-QRR3007. Quantitative Imaging Reading
i i = = i Room. &
LA DIEEITY Center Room. & Lakeside Learning Center Mo f:aTnin T
Hall E, Exhibit LL-QRR3007. Lakeside Learning Center Hall E, Exhibit LL-QRR3007. --- v C?RR3007
1:30pm-6:00pm: 3D Slicer Exhibit: Hall E, Exhibit LL-QRR3007. 1:30pm-6:00pm: 3D Slicer Exhibit:
Q
Q - g ve Imaging
Room. & . Ruom..rt}‘
Lakeside Learning Center paKesice .Ll?arnlng Center
Hall E, Exhibit LL-QRR3007. Dl E IRt DECLORRI00T

Questions: spujol@bwh.harvard.edu
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www.slicer.org
WWW.Na-mic.org

Questions and comments: spujol@bwh.harvard.edu
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